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Introduction

SAGE (Science Analysis Graphical Environment) is the implementation of the GUI written to run under
UNIX and VMS.  SAGE is designed to facilitate science data processing analysis by giving the user tools
to build, maintain and run processing flows.  The tools available are a Program Search tool for selecting
and starting programs with a search criteria tool to aid in finding the right program, a Toolbox tool for
organizing frequently used programs and allows program startup, a VPL (Visual Programming
Language) which allows the user to visually create processing flows, that is programs selected via the
Program Search Tool and the Toolbox, are chained together via input and output ports, and a Parameter
Box Tool,  that gives the user access to the program parameters.   SAGE is both a client and server
application.  The server controls the programs, parameters and program execution while the clients, the
Toolbox, the Parameter Box, etc., allow the interface to the programs.  Each tool was developed
independently, so FRs should indicate which tool the bug was found in.  For more information on the
VICAR GUI see the User Interface Design memo, IOM IPSD:384-93-009 dated 2/5/93 by Bob Deen and
Danika Jensen.   Also,  the most updated and complete information is available on the web, at the
following URL:  http://www-mipl.jpl.nasa.gov/sage/sage.html.

The documented features are to aid in the testing of the program.  Some familiarity with UNIX, VMS,
Motif, and the writing of VICAR pdfs or UNIX/VMS scripts.  Only the capabilities described should be
tested and FRs on items not yet implemented are not necessary.  You should note that most filename
specification examples are of the UNIX format.  Use the VMS format when using the VMS machines.

Save all core files when the program quits unexpectantly on UNIX.  This will help the programmers in
fixing the problem.  And be prepared to wait when starting up any of the tools on the VMS machines.

A good source for test images is in /usr/local/images/ on Unix or in IMAGES: on VMS.

Please consult the programmers if you do not understand something.  All comments are appreciated.

1.0 SAGE Program startup

This section describe how to start execution of the application SAGE from UNIX and VMS  and supplies
the user with examples.  Once the SAGE server is started, it allows access to all the other client tools
available.  SAGE tools are for selecting and starting the needed programs (which can be VICAR, AESOP,
...), establishing connections between the programs through inputs and outputs, allowing the user to save
their design, and executing the chained or connected programs.   These capabilities essentially allow the
user to create a script or pdf visually.

1.1  What to expect at startup

Startup of "sage" is done at the host machine command prompt, which is the UNIX shell prompt or
DCL level prompt.  The user is forewarned that if they open up all the tools and several parameter
boxes that screen space will become cluttered quickly.  Organizing your screen as tools are opened is
recommended.  Also closing tools when not needed is also recommended.  Once the user becomes
familiar with SAGE they will tend to build toolboxes and bring up only those tools that they need,
and stack all the parameter boxes on top of each other or keep only those needed, open.
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Note: A useful  Motif key combination is pressing the diamond key and the left mouse button, at the
same time,  over any stack windows.  This will send the selected window to the back.  The user can
use this to shuffle through stacked windows.

1.2  Examples From the UNIX shell level:

Execution Syntax:
% sage &  (the & will run sage in the background leaving your window free to do other stuff).
% sage first.sage & (SAGE will start up with first.sage as the current project.)

1.3  Examples From the VMS DCL level:

Define the following symbol if not already defined.  $sage:== $gui$lib:sage.exe
You can put it in your login.com file.

Execution Syntax:
$ sage

       $ sage first.sage

1.4 Remote Execution

SAGE also can be executed remotely (on more than one machine.)  Currently remote execution 
requires a few manual steps and it is not easy to use.  See the SAGE web page for more details:
www-mipl.jpl.nasa.gov/sage/prog_notes/remote_exec.html

2.0 Program Capabilities from the SAGE Window

The SAGE Window is displayed upon startup of sage and is labeled SAGE server.  The SAGE Window is
the main window containing a Motif border, a Menu Bar, a Run Programs button and an informational
area  with the words Current Project, and Project List.  All the following described capabilities are
available through the main window.

Check that the following works for the Motif Border:
Close Box quits the application
Iconify works
Restore iconify returns with same state
Maximize/minimize box works
Resizing from shell borders works

2.1  Menu Bar

Note: All Menus are pull down menus and are also tear-off menus.  By selecting the dashed line at
the top of a pulled down menu will put the menu into its' own window.  The window will contain a
Motif Border in which the user can use the close box to close the tear-off menu.

2.1.1  File Menu

This menu contains the following choices:  New Project, Open Project, Save Project, Save Project As 
and Close Project.
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2.1.1.1  New Project Button    (Ctrl+N)
Selecting the New Project will add a new project named <None> to the Project List.  Also a
new VPL window will appear and become the current VPL window.  If another project was
already open, the new project will not close it; the new project will contain separate
windows, and be displayed besides the old project.  (see Section 6.0 for more information on
the VPL).
Test this button with and without active programs.  To activate programs, do this through
the Program Search Tool or the Toolbox tool.  You can switch between projects by clicking on
the project name in the Project List.
Test if Ctrl+N keystroke combination will create a new project.  (First make sure to select the
SAGE window as the current window - the Motif border should be highlited.)

2.1.1.2  Open Project Button   (Ctrl+O)
The Open Project button brings up an Open SAGE Project file selection window.   The project
name that appears in the SAGE server window next to the label Current Project: should also
appear in the Selection box of the selection window.
Check that all Motif Border boxes work on the File Selection Box:

Close Box closes File Selection Box
Iconify works
Restore iconify returns with same state, can also restore by selecting the Open Project

button again.
Maximize/minimize box works
Resizing from shell borders works

Test the Filter text field and the Files field

Note: to delete in the text fields, use the Del key and not Back Space.  I was informed that
on an X-terminal, it might be Backspace.

The default filter text is to look for all files in the user's current directory ending with .sage.
To change the location, double click on the default text in the Filter text field and type in
/home/hbm/demo or any directory containing project files and hit return or click on the
Filter button at the bottom of the window.  (Note: project filenames do not need to end in
".sage", but it is recommended.)  Select a project file from the Files Box by single clicking on
the filename.  This will update the Selection text field.  (Use the scroll bar to move up and
down to show other files if they extend beyond view area.)  Double clicking on a selected
filename will fill in the Selection text field, close the File Selection Box and open up the
project.  It acts the same as if the user had clicked OK.

The Directories field can be tested by clicking on one of the listed directories and noticing the
change in the Files box and the Filter text.

Check all the Dialog buttons:
OK - should open the selected project and close the File Selection Box
Filter - should activate the Filter text box
Cancel - should close the File Selection Box with out opening a project
Help - should bring up help on the File Selection Box but currently is on SAGE.

Note:  If a project cannot be opened, an error message will be printed on your xterm window.
This will eventually be captured and placed in a information dialog window.  Do not FR it.

Test if Ctrl+O will open a project.
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2.1.1.3  Save Project Button   (Ctrl+S)
The Save Project button should be greyed out if there is no active project loaded or being
worked on.  A project is active if the Text information for Current Project in the SAGE server
window does not say <None>.  If a session has been opened or saved as a project, then this
button will be active.  It is used to save the current configuration, meaning all the currently
active programs and their parameters are saved.  A project file saved on UNIX cannot be
used on VMS or on other UNIX operating systems (eg. SunOS vs Solaris.)  Currently a
message on the user's xterm window will be printed saying the file has been saved.  This may
change.

Test if Ctrl+S will save the current project. (SAGE Server window should be the active
window for this keystroke to work.)

2.1.1.4  Save Project As... Button   (Ctrl+A)

The Save Project As... button brings up a Save SAGE Project As Files Selection window and
works similarly to the Open Project file selection window.
Check that all Motif Border boxes work on the File Selection Box:

Close Box closes File Selection Box
Iconify works
Restore iconify returns with same state, can also restore by selecting the Open Project

button again.
Maximize/minimize box works
Resizing from shell borders works

Test the Filter text field and the Files field

Note: to delete in the text fields, use the Del key and not Back Space.  I was informed that
on an X-terminal, it might be Backspace.

The default filter text is to show all files in the user's current directory ending with .sage.  To
change the location, double click on the default text in the Filter text field and type in
/home/hbm/demo or any directory containing project files and hit return or click on the
Filter button at the bottom of the window.  (Note: project filenames do not need to end in
".sage", but it is recommended.)  Type into the Selection field the filename or select a
filename from the Files Box by single clicking on the filename.  Selecting from the Files box
will update the Selection text field.   Double clicking on a selected filename will fill in the
Selection text field, close the File Selection Box and save the project.  It acts the same as if
the user had clicked OK.  Be careful not to write over something that you really want
saved.

The Directories field can be tested by clicking on one of the listed directories and noticing the
change in the Files box and the Filter text.

Check all the Dialog buttons
OK - should save the specified project and close the File Selection Box.  Test to see if both

the old project and newly created project file exist in local directory.
Filter - should activate the Filter text box
Cancel - should close the File Selection Box with out saving a project
Help - should bring up help on the File Selection Box but currently is on SAGE.

Test if Ctrl+A will bring up a Save SAGE Project As box. (SAGE Server window should be
the active window for this keystroke to work.)
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2.1.1.5   Close Project  Button   (Ctrl+C)
The Close button will close the current project’s VPL window and remove the current project
from Project List.  However, if the current project was modified and not yet saved, the Close
button will first bring up a dialog box that asks if you want to save the project.
Test the three choices for the dialog box:  Yes, No and Cancel.  If you press Yes, then the
current project will be saved and closed;  if you press No, then the current project will be
closed and all the changes will be discarded.  Finally, if you click Cancel, you will return to
the current project and can continue working.

Test if Ctrl+C will close the current project.  Close both a new project and an existing project
that you did not modify. (SAGE Server window should be the active window for this
keystroke to work.)

2.1.1.6  About Button   (Ctrl+B)
The About button brings up an informational dialog with the names of all the people
involved in implementing SAGE and the SAGE web page address.  Hit CLOSE to close the
box.
Check that all Motif Border boxes work on the File Selection Box

Close Box closes the About Dialog Box
Iconify works
Restore iconify returns with same state, can also restore by selecting the About button

again.
Maximize/minimize box works
Resizing from shell borders works

Test if Ctrl+B will bring up the About box. (SAGE Server window should be the active
window for this keystroke to work.)

2.1.1.7  Exit Button   (Ctrl+Q)
The Exit button will close SAGE and all the windows opened by it (tookboxes, VPL, XVD,
etc.) However, if the current project was modified and not yet saved, the Exit button will first
bring up a dialog box that asks if you want to save the project.
Test the three choices for the dialog box:  Yes, No and Cancel.  If you press Yes, then the
current project will be saved and SAGE exits;  if you press No, then the SAGE exits and all
the changes will be discarded.  Finally, if you click Cancel, you will return to the current
project and can continue working.

Test if Ctrl+Q will exit SAGE.  Exit both with a saved project and a modified one. (SAGE
Server window should be the active window for this keystroke to work.)

2.1.2 Tools Menu

The tools  menu is where the tools for selecting and chaining the programs to be used can be
found and activated.  This includes the Toolbox and the Program Search.  The temporary Test
Client  was removed but is described in Section 7.0.

Selecting the available buttons will activate the following tools.  Each tool is described in the
specified sections.

Toolbox   (Ctrl+T)- See Section 3.0
Program Search   (Ctrl+P)- See Section 4.0

Test if Ctrl+T brings up the toolbox and Ctrl+P brings up the program search. (SAGE Server
window should be the active window for this keystroke to work.)
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2.1.3  Help Menu

The Help Menu is a menu that gives you various types of help using Netscape.  If Netscape is
already running, SAGE will use it to display the help; otherwise, SAGE will open up a new
Netscape window.
Test each menu item - Netscape help should come up.  Netscape startup can be a little slow.

On Context - select, then move the cursor to any word in the SAGE Window and click on it
with the left mouse button.  Netscape help should come up

On Help - Netscape help on help. Not fully implemented.
On Window - Netscape help on the SAGE Window. Not fully implemented
Getting Started - Netscape help on how to start execution of SAGE.
Print Widget Tree - A pointed hand cursor appears;  clicking on any widget (Xmotif UI

Component) will display that component’s name and its parents.

2.2  SAGE Window Area

Below the SAGE menu bar is the SAGE Window Working Area.  It describes what programs the
server has loaded.

2.2.1  Run Programs Button

To execute the programs selected via the Toolbox or Program Search, just press the Run
Programs button.  If the VPL is open, the user will see the programs being stepped through by
highligthing the name of icon of those being executed.

2.2.2  Current Project Value

If a project file is opened or work from the VPL is saved as a project, the project name will appear
in the window next to the label Current Project, otherwise it will say <None>.

2.2.3  Project List

All projects that are started or opened SAGE are listed as buttons, vertically,  under the Project
List: text area.   Click on any button to make that project the current project.  Another window
with the project name as title will appear, which will list all the modules within that project
(Module List.) The module list grows and shrinks as programs are added and deleted.  A
program parameter box can be reopened from the Module List button.  Just press the program
button.

3.0 Toolbox Tool

The Toolbox Button starts up the Toolbox tool that allows the user access to commonly used programs
directly instead of having to use a search tool to find them.  The tool uses a default configuration pointed
to by the environment variable or logical (VMS) SAGE_TOOLBOX_SPEC to configure the available
toolboxes.  Currently, the user will have access to only those predefined toolboxes and programs in this
file unless the user would like to create his own and reset the environment variable to point the location
of the file.  (This is explained in section 3.1.1.5)

Upon startup, the user is presented with a Toolbox window containing a motif border, a menu bar and
display area showing the currently defined toolboxes.  The tool boxes and or programs are shown by icon
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only.  A single click with the left mouse button on a toolbox will open up the selected toolbox to show
more toolboxes and/or programs.  A single click with the left mouse button on a program will start the
Parameter Box for the selected program.  The Parameter Box is explained in Section 6.0.

Check that the following works for the Motif Border:
Close Box quits the Toolbox application
Iconify works
Restore iconify returns with same state
Maximize/minimize box works
Resizing from shell borders works

3.1  Toolbox Menu Bar

3.1.1  File Menu

This menu can be accessed by typing Alt+F when the Toolbar motif window is active.

3.1.1.1  Load Toolbox Config    (Ctrl+L)

The user selects the configuration file he would like to open to override the default
configuration which is pointed to by the environment variable SAGE_TOOLBOX_SPEC. By
double clicking on the file or by selecting the file with a single click and then pressing OK, the
user will see the toolbox display area change.

The Load Toolbox Config button brings up a Load Toolbox Config file selection window.
Check that all Motif Border boxes work on the File Selection Box

Close Box closes File Selection Box
Iconify works
Restore iconify returns with same state, can also restore by selecting the Open Project

button again.
Maximize/minimize box works
Resizing from shell borders works

Test the Filter text field and the Files field

Note: to delete in the text fields, use the Del key and not Back Space.  I was informed that
on an X-terminal, it might be Backspace.

The default filter text is to look for all files in the user's current directory.  Toolbox
configurations usually end with the .spec extension so the user can look for all *.spec files.
To change the location, double click on the default text in the Filter text field and type in
/home/hbm/demo/*.spec or any directory containing configuration files and hit return or
click on the Filter button at the bottom of the window.  (Note: configuration filenames do
not need to end in ".spec", but it is recommended.)  Select a configuration file from the Files
Box by single clicking on the filename.  This will update the Selection text field.  (Use the
scroll bar to move up and down to show other files if they extend beyond view area.)
Double clicking on a selected filename will fill in the Selection text field, close the File
Selection Box and open up the configuration.  It acts the same as if the user had clicked OK.

The Directories field can be tested by clicking on one of the listed directories and noticing the
change in the Files box and the Filter text.

Check all the Dialog buttons
OK - should open the selected project and close the File Selection Box
Filter - should activate the Filter text box
Cancel - should close the File Selection Box with out opening a project
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Help - should bring up help on the File Selection Box but currently is on SAGE.

Note:  If a configuration cannot be opened, an error message will be printed on your xterm
window.  This will eventually be captured and placed in an information dialog window.  Do
not FR it.

Test if Ctrl+L keystroke combination will load a toolbox.  (First make sure to select the
Toolbox window as the current window - the Motif border should be highlited.)

3.1.1.2  Save Toolbox Config    (Ctrl+S)

Eventually, the user will be able to configure a toolbox within the Toolbox tool by dragging
and dropping programs from the Program Search Tool into the Toolbox.  For now the user
can save the default configurations into local files and check to see if they load again in
different locations.  (i.e. save the personal toolbox and load it when you are in the galileo
toolbox).

There is currently a formatting problem with the configuration file so the user will not be able
to reopen the saved file.  This is a know problem so no FR is necessary.

The Save Toolbox Config button brings up a Save Toolbox Config file selection window.
Check that all Motif Border boxes work on the File Selection Box

Close Box closes File Selection Box
Iconify works
Restore iconify returns with same state, can also restore by selecting the Open Project

button again.
Maximize/minimize box works
Resizing from shell borders works

Test the Filter text field and the Files field

Note: to delete in the text fields, use the Del key and not Back Space.  I was informed that
on an X-terminal, it might be Backspace.

The default filter text is to display for all files in the user's current directory.  Toolbox
configurations usually end with the .spec extension so the user can look for all *.spec files.
To change the location, double click on the default text in the Filter text field and type in
/home/hbm/demo/*.spec or any directory containing configuration files and hit return or
click on the Filter button at the bottom of the window.  (Note: configuration filenames do
not need to end in ".spec", but it is recommended.)  Select a configuration file from the Files
Box by single clicking on the filename.  This will update the Selection text field.  (Use the
scroll bar to move up and down to show other files if they extend beyond view area.)
Double clicking on a selected filename will fill in the Selection text field, close the File
Selection Box and save the configuration file with that name.   It acts the same as if the user
had clicked OK. Be careful not to overwrite something that you want saved.  The user can
also specify the Selection by typing into the text field for Selection and then pressing the
OK button.

The Directories field can be tested by clicking on one of the listed directories and noticing the
change in the Files box and the Filter text.

Check all the Dialog buttons
OK - should open the selected project and close the File Selection Box
Filter - should activate the Filter text box
Cancel - should close the File Selection Box with out opening a project
Help - should bring up help on the File Selection Box but currently is on SAGE.
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Note:  If a configuration cannot be saved, an error message will be printed on your xterm
window.  This will eventually be captured and placed in a information dialog window.  Do
not FR it.

Test if Ctrl+S keystroke combination will save a toolbox.  (First make sure to select the
Toolbox window as the current window - the Motif border should be highlited.)

3.1.1.3  Undo    (Ctrl+Backspace)

Undo will undo the last command executed.  It only goes one level.

Test if Ctrl+Backspace keystroke combination will undo the last change.  (First make sure to
select the Toolbox window as the current window - the Motif border should be highlited.)

3.1.1.4  Exit    (Ctrl+Q)

Stops execution of the Toolbox Tool with a dialog box which ask the user if he would really
like to quit.

Test if Ctrl+Q keystroke combination will stop execution of Toolbox Tool.  (First make sure to
select the Toolbox window as the current window - the Motif border should be highlited.)

3.1.1.5  Configuration File Format

The Toolbox configuration file is simply an ascii text file containing lines of information that
describe the toolbox or program.  Look at the file pointed to by the environment variable
SAGE_TOOLBOX_SPEC for an example.  The user can easily create their own
configuration file with any text editor.

A typical line contains the following information:

NULL Name Alias Path Type Icon

where NULL is required at the beginning of each line, Name is the name of the toolbox or
program (Vicar programs do not need the .pdf extension), Alias is an alias for the toolbox
or program, Path is the location of the program icon or the toolbox configuration file, Type
is either the value TOOLBOX or PROGRAM, and Icon is the name of the icon to display
without the .xpm extension.  A value of none for the Icon, tells the toolbox to check the
server to see if an icon has been created for that program and if so use it, else use the
default icon.

Example lines describing a couple of TOOLBOXes and a PROGRAM:

NULL   galileo_tb.spec   GLLTools   $GUILIB   TOOLBOX  toolbox_gll
NULL   galileo_tb.spec   myGLLTools   /home/uid/demo/   TOOLBOX   none
NULL   galsos   GLLFixImage   $GUILIB   PROGRAM   none

3.1.2  View Menu

The view menu allows the user to setup how to view the contents of the toolbox.  The values are
self explanatory.

By Icon (the default)
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By Name
By Alias
By Icon & Name
By Icon & Alias

3.1.3  Edit Menu

3.1.3.1   Delete Item    (Ctrl+D)

Select the toolbox to be deleted by single clicking on it.  Then select Detete Item from Edit menu.
A dialog box will ask if the user really wants to delete the toolbox.  Click OK or Cancel to
continue.

Test if Ctrl+D keystroke combination will delete a toolbox.  (First make sure to select the Toolbox
window as the current window - the Motif border should be highlited.)

3.1.3.2   Change Icon

Prompts the user for the name of new icon to be displayed.  Icon files are ASCII files with
extension *.xpm, and can be found in $SAGEPATH.

3.1.3.3   Set Number of Columns

Will bring up a Column Dialog, where the user can type the number of columns, or can use Up
and Down Buttons to increment/decrement the value of current
Column Number.

When finished, the user can press Cancel to exit, or Close from Motif window border.

3.1.3.4   Vertical Toolbox

The following buttons are implemented as radio button, so only one is active at a time.
Displays the toolbox contents by expanding and formatting the toolboxes/programs in a vertical

direction.

3.1.3.5   Horizontal Toolbox

Displays the toolbox contents by expanding and formatting the toolboxes/programs in a
horizontal direction.

3.1.4  Help Menu

The Help Menu is a menu that gives you various types of help using Netscape
Test each menu item - Netscape help should come up.  Netscape startup can be a little slow.

On Context - select, then move the cursor to any word in the SAGE Window and click on it
with the left mouse button.  Netscape help should come up

On Help - Netscape help on help. Not fully implemented.
On Window - Netscape help on the SAGE Window. Not fully implemented
On Application - Netscape help for the highlited application (if  not available, an message

will be displayed instead of help.)
Print Widget Tree - A pointed hand cursor appears;  clicking on any widget (Xmotif UI

Component) will display that component’s name and its parents.
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3.2  Toolbox Display Area

The toolbox display area, is the area for displaying the toolboxes and programs.  By default, they are
viewed by icon only.  As long as the main toolbox window is open, all viewing preferences will stay
as set in the current session.  If  the main toolbox window is closed and reopened later, the settings
will start up as icon only again.

To open a toolbox or start up a program, single click on it.  Opening up a program will start up a
Parameter Box, add the program name to the SAGE server Module List and add a program icon to
the VPL if open.

4.0 Program Search

Introduction

The Program Search  Button (from SAGE Server Tools) starts up the Program Search tool that allows the
user access to all programs available.  Programs can either be VICAR programs or programs (such as
AESOP) defined by a SAGE dictionary file.  SAGE searches all directories defined by the environment
variable SAGEPATH for files ending with a ".dict" extension.  If no "*.dict" files are found, then SAGE will
look for all pdfs located in that directory and will include those as available programs.

Upon startup of the Program Search tool, a window containing a motif border, 2 scrollable lists appears
along with a menu bar and 4 buttons at the bottom.  The list on the left, is the list of all available
programs names and where they are defined.  The list on right is a description of the program.  Currently,
the user may not see any descriptions because they are not defined in the dictionary file.

Check that the following works for the Motif Border:
Close Box quits the Toolbox application
Iconify works
Restore iconify returns with same state
Maximize/minimize box works
Resizing from shell borders works

4.1  Program Search Menu Bar

4.1.1  File Menu

4.1.1.1   Exit   (Ctrl+Q)

Used to exit the Program Search tool.  Restarting the Program Search from the SAGE view menu
will start the program from the beginning.  Any criteria set will be lost.

Test if Ctrl+Q keystroke combination will exit Program Search.  (First make sure to select the
Program Search Tool window as the current window - the Motif border should be highlited.)

4.1.2  Help Menu

The Help Menu is a menu that gives you various types of help using Netscape
Test each menu item - Netscape help should come up.  Netscape startup can be a little slow.

On Context - select, then move the cursor to any word in the Program Search Window and
click on it with the left mouse button.  Netscape help should come up

On Help - Netscape help on help. Displays details on Program Search Help Menu.
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On Window - Netscape help on the Program Search Window.
On Keys - Netscape help on the accelerator keys.  Not  fully implemented.
On Version - Netscape help on the Version of SAGE.
Print Widget Tree - A pointed hand cursor appears;  clicking on any widget (Xmotif UI

Component) will display that component’s name and its parents.

4.2  Program Search List or Main Window Area

Program Names - The left list will list all programs that are available to SAGE and satisfy the current
search criteria.  By default, the search criteria is to list all available programs.

Program Descriptions - The right list of the main Program Search window will list all the program
descriptions.  Program descriptions are defined in the dictionary files as an annotation value.

The two lists are connected, in that they will scroll together.  Selections made by a single click with
the left mouse button over the program or description name in one list will hi-lite the corresponding
selection in the other list.  There is currently a problem with deselecting a selected program name or
description in that it will not deselect the other properly. This is a known problem and do not FR it.

Double clicking with the left mouse button on a program name or description will start the program,
add it to the SAGE server Module List for the current project, add it to the VPL if open and open its
parameter box.

4.3.  Program Search Button Area

The following buttons help the users perform searches:  View Directories, Criteria Search, Help On
Program and Program Examples.

4.3.1  View Directories

Selecting the View Directories button will bring up a dialog box with a motif border, a scrolling
list, an Add Path Text Field and a Delete Selected Path button.

Check that the following works for the Motif Border:
Close Box closes the View Directories dialog box.
Iconify works
Restore iconify returns with same state
Maximize/minimize box works
Resizing from shell borders works

Add Path Text Field -  Add the programs located in the specified path to the current SAGE
session.  Type in text and hit enter.  The Program Search will look for all files ending in ".dict"
and add those to the program search.  If no dictionary files are found, then all files ending in
".pdf" will be added.

Delete Selected Path Button - Select the directory to be deleted from the given list, scrolling if
necessary and hit the delete button.  All programs that reside in that directory will be deleted
from the Program Search list of available programs.

After Add/Delete Path, verify the changes in the Program Names list; it should update to show
the changes made.
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4.3.2  Search Criteria

Selecting the Search Criteria button will bring up a dialog box with a motif border, several keyin
text fields, and several option menus at the bottom.  All of the keyins and option menus
correspond to criteria that the program search will use when deriving the list of programs to
display.  By default, the fields all contain asterisks, which means everything or all.  The asterisk
can be used anywhere in the criteria values.  The asterisk means 0 or more of any character.  (i.e.
name=str* will search for all programs starting with the str.)  All pieces of criteria must be true to
display the program name.   Several of the keyin lists or option menus are empty.  This is because
the dictionary entry has not been updated with values to use.  The user can search by:

Name - keyin the program name
Directory - keyin for the directory
Dictionary - keyin for the dictionary name
Alias - keyin for an alias or the user can select from the list of all valid alias'.  The user can

press the Valid Alias's button to get a list of all valid alias' to aid the user in selecting the
proper program alias..  Single click or double click on the list entry to enter it into the keyin
field or select and press OK.

Keyword - keyin for a keyword or the user can select from the list of all valid keywords.  The
user can press the Valid Keyword button to get a list of all valid keywords to aid the user in
selecting the proper program keyword.  Single click or double click on the list  entry to
enter it into the keyin field or select and press OK

Parameter - keyin for a parameter or the user can select from the list of all valid parameters.
The user can press the Valid Parameters button to get a list of all valid parameters to aid
the user in selecting the proper program parameter.  Single click or double click on the list
to enter it into the keyin field or select and press OK.

Type  - Option menu giving the user all the valid values for program type.
Project - Option menu giving the user all the valid values for the program project.
Function - Option menu giving the user all the valid values for the program function.

4.3.3  Help on Program

Gives the user help on highlighted program.  If help is not available, an error dialog box will
inform the user.

4.3.4  Program Examples

Should get a dialog box saying that is currently not implemented.  Just press OK to continue.

5.0 VPL (Visual Programming Language)

The VPL allows the user to visually create a processing flow.  The user creates a processing flow by
chaining program icons selected via the toolbox or program search tool.  The VPL also gives access to the
programs parameter boxes, allows the user to move icons, and allows the user to delete programs.  The
tool  starts after opening a SAGE project or creating a new project.  The VPL tool  creates a window with a
motif border, a menu bar and an empty drawing area.

Check that the following works for the Motif Border:
Close Box quits the Toolbox application
Iconify works
Restore iconify returns with same state
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Maximize/minimize box works
Resizing from shell borders works

VPL Menu Bar

5.1.1  File Menu

Exit (Ctrl+Q)

 Exit the VPL with a dialog box asking if the user really wants to quit.

               Run

Runs the current project directly from VPL (you don’t need to click on Run Programs from SAGE
Server window anymore.)

5.1.2  Edit Menu

5.1.2.1  Select All    (Ctrl+A)

 Selects all the icons.  Now the icons become a group.  Test by dragging the icons to another position.

5.1.2.2.  Cut   (Ctrl+T)

Deletes the selected icon and keep it in its' buffer.  Not fully implemented.

5.1.2.3.  Copy    (Ctrl+C)

Copy the selected icon(s) and keep it in its' buffer.  Not fully implemented.

5.1.2.4  Paste   (Ctrl+P)

 Paste the last cut or copied item(s).  Not fully implemented.

5.1.3   Macros Menu

5.1.3.1  Create Macro

Will replace the group of selected icons by a single macro.  To select a group of icons, press the
Shift key, and click with the mouse over the icons.  After selecting all of the necessary icons,
release the Shift key.  The group of icons should still be selected.
After pressing Create Macro button, a new icon will be displayed.  The macro icon will have the
same input/output dataflows as the icons it replaced.
VPL is supposed to replace the selected group of icons with the single macro icon.  Not fully
implemented yet (Deliv 20.1)
Test by running the dataflow; saving and retrieving the SAGE project with macros.

5.1.4  Help Menu

The Help Menu is a menu that gives you various types of help using Netscape
Test each menu item - Netscape help should come up.  Netscape startup can be a little slow.

On Context - select, then move the cursor to any word in the SAGE Window and click on it
with the left mouse button.  Netscape help should come up

On Help - Netscape help on help.  User will see help information about VPL help.
On Window - Netscape help on the current  window.

Print Widget Tree – Same as before.
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5.2   Right-Mouse Button Menu

To use this menu, position the mouse over any icon displayed in VPL, and click the right mouse
button.  A menu with the following choices will be displayed.  Selecting any of the choices will
apply the selection to the current icon only.

5.2.1   Post Output Window

This command will create a X-window that will display the output of the selected program as is
the program was run from a terminal.

5.2.2   Set Icon

This command will bring up a text entry box, where the user can type the name of a new icon.  If
the icon is not available, the default SAGE icon will be displayed.

5.2.3   Set Program Name

This command will present a text input box where the user can type a new name for the selected
program.  From now on, the selected icon will display the new name.

5.2.4   Duplicate Module

After clicking on this command, the user will see another icon appearing.  The new icon will be
the same program, and if the old program has any input/ouput connections already made, the
new icon will share these connections.

5.2.5   Application Help

Netscape help will come up, and help will be displayed about the selected icon.  If help is not
available, a error message will be displayed instead.

5.3  VPL Drawing Area

The VPL displays all the programs started up by the Toolbox or Program Search Tools as program
icons and allows connecting them together with lines and movement of the icon positions.  The VPL
will highlight the program name that is being executed as the stream of programs is running.
Programs get executed by hitting the Run Programs button from the SAGE Server Window.

By default, the input and output parameters are defined to be data flow ports.  That means data will
flow from that program and into another.  Data flow ports are represented as small triangles attached
to the left (inputs) and right (output) sides of the program icon.  The user can then position the cursor
over any port, press the middle button and drag it onto a port of another program.  The user can tell
if the chaining is working by seeing a happy face icon appear while the middle button is pressed
down.  Upon positioning the little triangle of the happy face icon on top of the input or output port of
the destination program and releasing the button, a line should appear showing the connection
between the two ports.  If the line does not appear, the connection was not made.  Data flow inputs
and outputs can be changed to direct input and output via the parameter box for the program.

To open a parameter box from the VPL, the user needs to double click on the program icon.
Reconnecting an already existing connection can be done by the same method above.  Another
method of chaining is by dragging an icon port onto a parameter box input or output parameter and
vise versa and from parameter box input or output parameter to another parameter box input or
output parameter.  Some of the icon connections will disappear or just not show up.  This is a known
problem and a FR should not be written on it.

The user can create vertex points (also called knots or handles), on a connection line to allow the line
to be bendable.  This is helpful in keeping the VPL clean.  A vertex point can be added by pressing
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the middle mouse button as the cursor is on top of the line.  The vertex point can then be moved by
dragging it with the left mouse button, that is position the cursor over the vertex point and hold the
left mouse button down while positioning where you want the vertex point to be and then release the
mouse button.  Vertex points can be deleted by selecting the vertex point with a single click on the left
mouse button and then hitting the backspace key.

The user can select icons in order to move or delete them.  Single click with the left mouse button on
an icon to select.  Shift and single clicking on a second icon will select that icon and keep the previous
icon also selected.   The user can move the selected icons to other positions or the user may wish to
delete the select ed programs.  To delete a program, select the icon or icons,  and then press the
backspace key.  Deleting a program should remove the program button from the SAGE server
window, delete the icon from the VPL and close it's Parameter Box.

The user can insert comments anywhere in VPL drawing area.  The comments will be entered in a
text box;  this input box will become as wide as needed to accomodate the comment string.  The
comment box can be selected by clicking on the single line above the box;  then this single line will
become a double line, and the box can be moved anywhere inside VPL.   See Known Problems note at
bottom of this document for problems related to comments.

6.0 Parameter Box

A Parameter box appears automatically when a program is started from the Toolbox or the Program
Search tool.  The Parameter Box is used to modify the program parameters.  The Parameter Box is a
window containing a Motif border, a menu bar and an area listing all the program parameters and their
defaults.
The Parameter Box also displays the name of the program under the Menu Bar, after Module Name label.

Check that the following works for the Motif Border:
Close Box quits the Toolbox application
Iconify works
Restore iconify returns with same state
Maximize/minimize box works
Resizing from shell borders works

6.1  Parameter Box Menu Bar

6.1.1  File Menu

Load - Is greyed out and currently not implemented.
Save - Is greyed out and currently not implemented.

6.1.2  Edit Menu

Undo - Undo the last command.  Not implemented yet.
Clear All Entries - resets the parameters to their defaults.
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6.1.3  Options Menu

6.1.3.1 Duplicate Parameter Box

Start up another instance of the program/parameter box and keep the same parameters.  It will
add the program to the SAGE Server and VPL if open and open another Parameter Box with
the same set parameters as the original.

6.1.3.2  Auto Apply

Send any changed parameters to the server so the user does not need to hit apply after every
change to a parameter box.

6.1.3.3  Set Program Name

 select a new name to be displayed by the selected icon.

6.1.3.34 Post Output Window

 Opens a text window in which the output of the program gets directed to the window.
The Output window contains a menu bar with the following commands:  File and Options.
File Menu:
    Save Output Log - will ask the user for a file name and write     the output window’s contents

to that file.
Options Menu:
    Clear Output - Clear the output window of text.
    Clear Output on Every Run - Check box to set mode for clearing the output text in the text area
         before each run or to continue concatenating the output of each run in the window.
    Find – Prompts the user for a string, then search for the string in the output window.
    Find Next – Repeat the string search.

6.1.4  Help Menu

The Help Menu is a menu that gives you various types of help using Netscape
Test each menu item - Netscape help should come up.  Netscape startup can be a little slow.

On Context - select, then move the cursor to any word in the VPL Window and click on it
with the left mouse button.  Netscape help should come up

On Help - Netscape help on help. Will display help for Parameter Box help.
On Window - Netscape help on the Parameter Box window.
On Parameter - Netscape help for the highlighted parameter (if  not available, an message

will be displayed instead of help.)
On Application - Netscape help for the highlighted application (if  not available, an message

will be displayed instead of help.)
Print Widget Tree - A pointed hand cursor appears;  clicking on any widget (XMotif UI

Component) will display that component’s name and its parents.

6.2  Parameter Box Work Area

A Parameter box appears automatically when a program is started from the Toolbox or the Program
Search tool.  The Parameter Box is used to modify the program parameters.  The Parameter Box lists
all the program parameters and their defaults.  It can be closed and reopened via the VPL or the
SAGE server window.  From the VPL, reopen a parameter box by double clicking on the icon.  From
the SAGE server window, reopen a parameter box by pressing the program button that appears
under the Module List.  The parameter box is scrollable so the user can view all the parameters
available for the program.
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Each parameter  name has a pop up menu associated with it so by pressing the right or left mouse
button over any parameter name, the user will see values associated with it identifying the type of
parameter it may be.  Those types are:

no connection  -  available if data or name flow is selected and will remove a connection
direct - to directly specify a filename by typing it directly or from a file selection dialog
data flow  - if the data is to come from another program, dragged into from another parameter

box.  It is to be associated with a connection line.  A triangle will appear on the icon in the
VPL if the parameter is set to data flow on it.  Will automatically be set if a input or output
port is dragged onto the parameter.

named flow - is not currently implemented and is setting the parameter value to the name of a
data flow connection.  Data flow connections can be named.  It is essentially creating a data
flow by specifying a name.

default - set the value to be as define in the .pdf or dictionary file

There is also a show value selection that will just show the parameter value.

Parameters are set by selecting the keyin field which is to the right of the parameter name and typing
in the value.  Those parameters with a valid value list will be option menus.  This is currently not
fully implemented.  Check to make sure the correct value is entered.  The keyin fields may not take
the first couple of key strokes.  We are investigating this.

6.3  Work Area Buttons

OK - close the Parameter Box, applying the changes the user made.

Apply – incorporate the Parameter Box inputs into the dataflow, without closing the Parameter Box.
The user can still change parameters, change file names, etc.

Cancel – close the Parameter Box, discarding all the changes the user made.

7.0 Test Client

This feature is obsolete now.
The Test Client tool is a temporary tool.  It was written for testing purposes before the Program Search
and ToolBox capabilities became available.  It is essentially a window containing icons and program
names of a set of programs that are best suited for testing, and connection ids are listed for debugging
purposes.  The user can single click on the icon or name button to start up a program.  The program name
gets added to the botton of the test client window as a button as well as the SAGE Server Module List, the
VPL and opens a Parameter Box.  Single clicking on a program name button in the Test Client will delete
the program.

8.0 Resources

Many of initial startup modes and labels for the various boxes and text fields can be changed by the user
in the users own  .Xdefaults file under UNIX or in a copy of the .DAT files for VMS.  The user can find the
program defined resource files, SageServer, Vpl, progSearchApp, ToolBox,  or AutoSpb, located in one of
the paths defined by the environment variable XFILESEARCHPATH under UNIX and determine the
resource name to change.  Under VMS, the files, SAGESERVER.DAT, VPL.DAT,



22 22

PROGSEARCHAPP.DAT, TOOLBOX.DAT, or AUTOSPB.DAT,  should be found in the
DECW$SYSTEM_DEFAULTS defined logical name location.

Examples of the resources that can be specified are:
    -mnemonics and accelerators
    -URLs for context-sensitive help; type of web browser to be used (Netscape or Mosaic)
    -window, foreground and background color
    -font type, label strings
….and many more.

9.0 Included Features and Some not Yet Implemented

The features included in this delivery of SAGE and some not yet implemented are identified below along
with any know problems.  Please do not FR the known problems.

SAGE Server Window
Saving, Opening of project files
Closing of project files (NEW)
Program Project List management (includes clearing all)
ToolBox, Program Search access
Web-based help menu (NEW)

               NOTE:  on VMS, SAGE still tries to use Netscape to display the help.  However, if
you assign:  $netscape :== $local_disk:[bin]xmosaic.exe then the help will run Mosaic instead
of Netscape.

VPL
Icon display  and selection and manipulation (moving icons around)
Deletion of icons
Parameter Box access
Icon chaining (making connections) and manipulations (drag and drop)
Creating Macros (NEW)
Comments (after adding comments, icons cannot be deleted anymore.)

Toolbox
View by name, icon only, icon and name,  icon and alias, alias
Viewing manipulation
Program Startup
Configuration file loading and saving.

Parameter Box
Scrolling Display of Parameters
Direct entry
Data Flow entry

Program Search
Display of program names and descriptions
Search Criteria Manipulation (search by name, directory, dictionary, alias, parameter, keyword,

function, type, and project).
Adding and Deleting Path
Program startup
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Program Help/Examples (Not implemented)

SAGE web page: http://www-mipl.jpl.nasa.gov/sage/sage.html (NEW)
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